
 

 

 



 

 2

Contents 

Introduction ................................................................................................................................. 4 
Welcome ....................................................................................................................................... 4 

What’s New in MultiRack v9 ........................................................................................................ 4 

Product Overview ........................................................................................................................ 5 

Quickstart Guide .......................................................................................................................... 5 

Installing Waves Software .......................................................................................................... 6 

Now it’s time to authorize your plugins : ................................................................................... 6 

Connect Your Console to the Sound Card or External I/O ....................................................... 7 

Create a New Session and Set the Preferences ........................................................................ 9 

Plugin Manager (working with v8 and v9 plugins) .................................................................. 10 

Add Empty Racks ...................................................................................................................... 10 

Add Plug-ins for Sound Processing ......................................................................................... 13 

Setting up Side Chain ................................................................................................................ 14 

Snapshots .................................................................................................................................. 15 

Create Processing Groups ....................................................................................................... 16 

Saving in MultiRack ................................................................................................................... 18 

Recall Safe Mode ....................................................................................................................... 18 
Overview Window: Viewing the Status of All of Your Racks ......................................................... 19 

Controlling MultiRack with MIDI ............................................................................................... 21 
How is MIDI Used with MultiRack? .............................................................................................. 21 
The Controller Strip ..................................................................................................................... 21 
Assigning Hardware Control with the Remote Controller Editor ................................................... 23 
Remotely Triggering Snapshots ................................................................................................... 25 
Hot Plug-ins ................................................................................................................................. 25 

Hot Plug-in Panel ....................................................................................................................... 26 

Show Mode ................................................................................................................................ 27 

Shortcuts That Are Always Available ....................................................................................... 27 

Automatic Recovery .................................................................................................................. 27 

Rescan Present Licenses (Edit Menu) ..................................................................................... 27 

MultiRack Windows and Controls Explained........................................................................... 28 
Status Bar.................................................................................................................................... 28 
MultiRack Window ....................................................................................................................... 30 
Rack View Window ...................................................................................................................... 31 
Group Properties Window ............................................................................................................ 31 
Snapshots Pane .......................................................................................................................... 31 
Preferences Window ................................................................................................................... 32 
Hot Plug-in Panel ......................................................................................................................... 32 

The Windows in Detail ............................................................................................................... 32 
MultiRack Main View: Setting Up Your Processing Environment ................................................. 33 



 

 3

The Rack Control Strip ................................................................................................................ 34 
Selecting Racks and Using Keystroke Commands ...................................................................... 35 
Input and Output Sections ........................................................................................................... 38 
Adding Plug-ins to a Rack ........................................................................................................... 38 
Rack View: Using Your Plug-ins .................................................................................................. 40 
WaveSystem Toolbar Buttons ..................................................................................................... 41 
Controller Strip ............................................................................................................................ 42 
Group Properties Window: For Organization and Latency Alignment ........................................... 43 
Snapshot Pane: Automating Your Racks ..................................................................................... 45 
Hot Snapshots ............................................................................................................................. 48 

Preferences Window: Global Controls ..................................................................................... 49 
System Setup – Audio Section .................................................................................................... 49 
System Setup – System Section .................................................................................................. 49 
Plugin Manager (working with v8 and v9 plugins.) ....................................................................... 51 
Control Setup Tab ....................................................................................................................... 52 

Hot Plug-in Panel ....................................................................................................................... 53 

MultiRack Menus ....................................................................................................................... 54 
File Menu .................................................................................................................................... 54 
MultiRack Menu (OS X only) ....................................................................................................... 54 
Edit Menu .................................................................................................................................... 55 
View Menu ................................................................................................................................... 56 
Audio Menu ................................................................................................................................. 57 
Snapshots Menu.......................................................................................................................... 57 
Help ............................................................................................................................................. 58 

 



 

 4

 

Introduction 

 

Welcome 

Thank you for choosing Waves. In order to get the most out of Waves MultiRack, please 

take the time to read through this manual.  

 

In conjunction, we also suggest you become familiar with www.wavesupport.net. There you 

will find an extensive Answer Base, the latest Tech Specs, detailed Installation guides, 

new Software Updates, and current information on Authorization and Registration.  

 

By signing up at www.wavesupport.net, you will receive personalized information on your 

registered products, reminders when updates are available, and information on your 

authorization status. 

 

What’s New in MultiRack v9  

• Waves V9 & V8 plugin support 

• No More iLok. Keep your licenses on your Host computer’s hard drive or USB flash 

drive. 

• Quick initial Setup and Routing: When launching a new session, choose from a list 

of session templates, both factory made and you own saved ones, to quickly load 

Racks.  

• A new “Auto Route All Racks” Edit menu option that assigns I/Os to all Racks 

consecutively and automatically. 

• Quickly access your most important “Hot Plug-ins”: New Hot Plug-ins floating panel 

(View menu) that holds clickable shortcut buttons to your Hot Plug-ins - click on a 

button to open the plug-in’s Rack View. 

• Prepare Setup and Routing without licenses– If plug-in licenses are missing, plug-ins will 

load in a disabled state. While the plug-in won’t process audio you can assign inserts, FX, 

load plug-ins. To enable disabled plug-ins, insert your USB Flash Drive (V9) (for V8 

plugins use your iLok key). Run Plugin Manager and Rescan Present Licenses to re-

enable plugins. 
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Important: 
v9 Licenses can be activated only on the USB Flash Drive.  
v8 Licenses can be activated only on the iLok Key.  
 

Product Overview 

MultiRack is a host platform for Waves audio processing plug-ins, designed especially for 

live sound applications. It provides a software equivalent to outboard hardware processing 

Racks, and signal flow to and from your console is similar to what you’re accustomed to 

with traditional hardware Racks. MultiRack allows you to program up to 1000 Snapshots 

per Session, so you can seamlessly change setups between or even within songs.  

 

 

Quickstart Guide 

The Quick Start section contains all you need to know to configure your system and to get 

up to speed with the application.  

 

We will follow these steps: 

1. Install Waves Software and Plugins 

2. Connect your console to the sound card or external I/O 

3. Create a new Session and set the preferences 

4. Add new Racks and set their audio signal flow 

5. Add plug-ins for sound processing 

6. Setting up side chain 

7. Create Snapshots for easy recall of Racks and processors 

8. Organize Racks into groups for ease of operation and latency management 

9. Set up your MIDI environment for remote control 

 

After the Quick Start chapter is a detailed description of MultiRack’s interface, so if you 

have a question about a particular button, function, or feature, this is the place to look. At 

the back of this manual, you’ll find details of MultiRack’s application menus.  

 

Follow the steps in the Quick Start guide, and then experiment with a Session of your own. 
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It won’t be long until you’re managing complex concert setups with ease. 

Please note: Throughout this manual, keyboard shortcuts indicating Ctrl/Cmd refer to 

Windows (Ctrl) and Mac (Cmd) respectively. 

Installing Waves Software 

 

Please refer to MutiRack Native Download page for detailed instructions: 

http://www.waves.com/content.aspx?id=10122  

Now it’s time to authorize your plugins : 

 
• Launch Waves License Center (installed on your computer as part of Waves Software 

Installation) to authorize your plugins. Internet connection required. 

For step by step instructions visit: http://www.wavesupport.net/content.aspx?id=4219 
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Connect Your Console to the External I/O 

 
Before starting the application, connect your console to your sound card or external I/O. It’s 

useful to make a chart of the connections, so that when you assign Racks to specific I/O 

channels, you won’t need to look behind your console. 

 

MultiRack signal flow to and from your console is similar to what you’re used to with 

external hardware processors: Some connections will be from aux sends on your console, 

with returns on faders; others will be from channel inserts. You may also choose to connect 

via a patch bay or router.  
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Here are some flowchart examples of MultiRack connections. For more about Rack I/O 

configurations, see the detail section “MultiRack Window: Setting up Your Processing 

Environment.” 
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Create a New Session and Set the Preferences 
A Session is a collection of Racks, each of which contains plug-in processors. It holds the 

“architecture” of your setup (input and output routing, how many Racks, in what order, 

which plug-ins and their order, etc.), as well as Rack I/O levels and plug-in settings. 

Normally, a Session will contain the setup for an entire show, while Snapshots are used to 

change settings between or within songs.  

 

MultiRack will initially open “Session Templates” window. Choose a template from the list or 

open a blank session. Then, MultiRack will open to the most recent Session. 

 

 

Get started by accessing the 

Preferences window: Ctrl+P in 

Windows/Cmd+, on Mac). Set the audio 

I/O device by clicking the Audio Device 

dropdown and choosing from the 

available devices. (MultiRack supports 

Windows ASIO and Mac CoreAudio 

sound cards.)  
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Plugin Manager (working with v8 and v9 plugins) 

 

 

Click Plugin Manager Tab in Preferences. 

MultiRack V9 supports both V8 and V9 

plugin versions. Depending on what license 

you have or intend to work with select V8, 

V9 or both and click Ok. Both plugin 

versions are installed on your PC. Checking 

the version entry in the Plug-In Manager 

tells MultiRack what version(s) you want it 

to scan when it loads. You can change your 

selection at any time.  

 

 

Add Empty Racks 
A Rack is a chain of plug-ins used to process an audio signal, whether mono, stereo, or 

mono-to-stereo. In the hardware world, signals flow from a console’s channel insert or aux 

track, are processed with a collection of outboard gear, and then returned to the console. 

MultiRack follows the same principle, except that processing takes place in virtual Racks 

filled with plug-in processors rather than in hardware racks.  

 

The first step in building a MultiRack processing setup is to add empty Racks.  

Double click on the area that says Double Click to Add Rack.  
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This will reveal a dialogue box that asks how many Racks 

you want to add, as well as what type of Rack (Mono, 

Stereo, or Mono-to-Stereo). Don’t worry about making the 

wrong choice; you can always change this setting later. 

 

 

Now you’ll see one or more empty Racks. Define the 

audio input and output channels of each Rack by clicking 

on the left (input) and right (output) side rails of the 

interface. The Audio I/O pull-down menu will open. The 

number of channels available depends on the I/O device 

you are using. Set the channel(s) for both input (left side 

rail) and output (right side rail) for each of the Racks 

you’ve created. 

Use the “Auto Route All Racks” option found in the Edit menu (Ctrl/Cmd+U) to assign I/Os 

to all Racks consecutively, based on their top-down order in MultiRack’s main window. 

 

 

 

 

You may decide later to change a Rack’s input 

from mono to stereo, or to mono-to-stereo. Use the 

Switch Rack Type pull-down to modify the input 

and/or output.  

 

 

 

 

As you add Racks, a blank area will appear beneath the newest Rack. Double click in area 

to add more Racks, up to a maximum of 64. 
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Just as it’s important to write on the scribble strip of your console to identify the source of 

each channel, it’s equally useful to name the Racks of your MultiRack Session. Label a 

Rack by clicking, then typing, in the Rack name text 

cell at the top of the Rack. In this example, we’ve 

labeled the Rack “Hi Hats.” 

 

 

To delete a Rack, right click on it and choose Delete Rack from the menu, or choose 

Delete Selected Racks from the Edit menu.  

 

This is a good time to Save your Session. Look in the File menu for the command, or type 

Ctrl/Cmd+S. 
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Add Plug-ins for Sound Processing 

Once you’ve created Racks and assigned their I/O channels, it’s time to add plug-ins to 

each Rack. A Rack can hold up to eight plug-in processors, and the signal will always flow 

from left-to-right.  

 

Click on the small arrow near the Input Fader to add a plug-in from the pull-down list. Plug-

ins are organized by type of processor. Add another plug-in by clicking on the arrow to the 

right of the first plug-in, and so forth. You can always rearrange the plug-in order by clicking 

on a processor and dragging it to the desired position.  

 

 

 

 

 

 

 

 

 

 

 

 

 

To view a plug-in and adjust its parameters, double click on the box representing it. The 

plug-in’s interface will appear below the Rack. This view is called Rack View. Set the plug-

in as desired. At the top of the interface of all Waves plug-ins is the WaveSystem toolbar, 

which is used to load or save your favorite settings for that plug-in. Learn more about the 

WaveSystem Toolbar in this manual’s section entitled “Rack View: Using Your Plug-ins.” 

 

To exit Rack View and return to MultiRack window, double click on any empty area at the 

top of the Rack, or click the red [X] button on the right. To move to another plug-in interface, 

simply double click on the plug-in you’d like to see. You can also navigate between the 

plug-ins in a Rack by using the left/right arrows on your keyboard. To delete a plug-in, right 

click on it and choose Remove Plug-in. (This action is undo-able.) 
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Setting up Side Chain 

New in version 2.0, the Rack supports side chain input. Each Rack can be set to receive side 

chain from any of the IO device inputs (one of the inputs set in the Connections window). Side 

chain is used by some plug-ins to modify their behavior, e.g. to allow ducking by a compressor 

plug-in. A stereo Rack can receive a stereo or mono side chain signal, a mono or mono-to-stereo 

Rack can receive mono side chain signal. 

In the Rack’s top section there is a new drop-down menu titled “Side Chain”. In this menu you set 

the input that will be feeding the side chain signal to the respective Rack. 

 

 

 

Select the input source you want to feed as side chain to the Rack. 

Insert a side-chain capable plug-in. A side-chain capable plug-in is marked SC. 

 

 

Right-click on the plug-in and select Enable Side Chain from the right-click drop down menu. This 

will enable side chain for that respective plug-in. A side chain enabled plug-in is marked by a 
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yellow In button (regular In button color is green). 

The same device input can be used for Rack input and side chain simultaneously.  

Note that the same side chain signal can be fed to more than one plug-in in the Rack. 

 

Snapshots 
With MultiRack, you can easily store and recall Snapshots of the Racks and the plug-ins 

they contain. A Snapshot is sort of a “super preset,” a picture of all of the Racks in your 

MultiRack Session. It contains the following parameters: 

 

• Rack input and output gain 

• Rack in/out and mute states 

• Current plug-in parameters 

 

Snapshots are contained and saved as part of a Session file. A single Session file can 

contain up to 1000 Snapshots. Snapshots can also be exported to or imported from files in 

order to integrate them into a Session.  

 

Use Snapshots to change the state of Racks (mute/out), levels, and most importantly, the 

settings for the plug-ins. Snapshots do not change the physical configuration of a Session, 

so you cannot use a Snapshot to change the audio I/O, the Rack order, or the plug-ins in a 

Rack. However, since Snapshots can take plug-ins in and out of the processing path, you 

can insert several plug-ins into a Rack, and then control which are in use in specific 

Snapshots. 

 

Snapshots are stored, recalled, and managed in the 

Snapshot Pane. To open this window, click the Snapshots 

button. 

 

 

 

Here, you can store up to 1000 Snapshots. We’ll discuss the 

Snapshots Pane in greater detail later in this manual. For 
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now, it’s sufficient to know that first you should set your I/O levels and plug-in parameters 

as desired, then click on a Snapshot register where you want to store the information.  

 

 

Click Store As…. This will reveal the Store Snapshot As 

window.  

Type a name for this Snapshot and click Store. In the image 

to the left, we’re adding a Snapshot for the chorus of “Song 

#2,” and storing it into Snapshot slot #0004. 

 

To recall a Snapshot, double click on a defined Snapshot in 

the Snapshot Pane, or select the desired Snapshot, then 

click on Recall. The functions in the Snapshot Pane are 

pretty logical, so you can learn how it works through 

experimentation. Refer to the next section of this manual, 

“MultiRack Windows and Controls,” for more details about 

these features. 

 

Create Processing Groups 
Since MultiRack allows you to build Sessions of up to 64 Racks, each of which are specific 

processing chains, you may choose to organize related Racks into groups to better manage 

your Session. Grouping Racks offers a few advantages: 

 

• Group related Racks together (such as all drum channels), and they will share a 

common group name. 

• Groups are color-coded, making visual identification of similar Racks much easier. 

• Grouped tracks can be latency-aligned, offsetting unequal delays caused by each 

channel’s chain of plug-ins, which may have different latencies. 
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 Create a group by clicking on the 

grouping pull-down menu and choosing 

Open Group Properties window. Here 

you create Rack groups and determine if 

and how Racks within the group will be 

latency-aligned.  

 

 

 

In this example, we named the group 

“Drums.” Each new group is automatically 

assigned a color. (We will discuss latency 

alignment in more detail in the section 

“Group Properties Window: For 

Organization and Latency Alignment.”) For 

now, choose Auto, which sets the latency 

of all Racks in the group to match that of 

the Rack with the greatest latency. 

 

 

 

 

Close the window. 

 

 

To add more Racks to a group, click on the Group Properties pull-down menu, where the 

group name will appear, and then select 

the group that you want the Rack to belong 

to.  
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Saving in MultiRack 
MultiRack offers four different levels of “Save,” enabling you to quickly and confidently store 

and recall needed Session information. From most specific to most general, here are your 

options for saving information: 

• Per Plug-in: Each plug-in has its own WaveSystem Toolbar, so you can load and save 

your favorite plug-in settings without affecting the rest of the processing environment. 

Say you have a C4 preset that you’d like to use for the bass. Simply load the preset 

from the C4’s WaveSystem Toolbar’s Load menu. 

• Per Rack: There’s a WaveSystem Toolbar at the top of each Rack, so you can load and 

save settings for an entire Rack, independent of the Snapshots. 

• Snapshots are used to store your plug-in and Rack settings. 

• Sessions hold the settings for every plug-in, Rack and Snapshot, and contain the 

information about the architecture and signal flow for the entire setup.  

Recall Safe Mode 
There are times when you don’t want certain Racks or specific plug-ins to be affected by 

Snapshot changes. The Recall Safe Mode allows you to select the Racks and/or plug-ins 

that won’t be affected as you change Snapshots that would normally affect them. The 

recall-safe option applies within the Session (not a specific Snapshot). 

 

To set a Rack or plug-in to Recall Safe: 

• Select Recall Safe in the Snapshots menu, or type Ctrl/Cmd+Shift+R. 

• Racks: Select a Rack or multi-select several Racks, then right click in any empty area of 

the Rack. Select Recall Safe from the pull-down menu. A Rack’s blue input/output rails 

indicate that it is in Recall Safe. 

• Plug-ins: Select the plug-in or plug-ins you want to set to Recall Safe. Right click on any 

of the selected plug-ins and choose Recall Safe from the pull-down menu. Recall Safe 

plug-ins glow blue. 

• To remove a Rack or plug-in from Recall Safe mode, de-select Recall Safe from the 

right click menu in Recall Safe mode. 

• Plug-ins or Racks that are set to Recall Safe can be edited. However, their Recall Safe 

status can be viewed only while in Recall Safe mode. 

• Selecting Recall Safe in the Snapshots menu does not activate or de-activate Recall 

Safe. Rather, it only allows you to see plug-ins and Racks and set them to Recall Safe. 
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When you turn Recall Safe mode off, Racks and plug-ins which have been Recall Safe 

remain so; they just don’t glow blue. 

 

 

 

 

 

 

 

Overview Window: Viewing the Status of All of Your Racks 

Once you’ve filled several Racks, you’ll want a convenient way to keep track of everything 

happening within your processing environment. To get an overview of your Racks, select 

Overview from the View menu. This will reveal the Overview Window, where you’ll see a 

condensed view of each Rack.  

 

 

 

 

 

 

 

 

 

 

 

 

The Overview Window tells you if a Rack or an individual plug-in is functioning, and it 

enables you to turn on or off, bypass, or mute a Rack. Clipping is also indicated for each 

Rack. 
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Use the Overview Window when you want to keep an eye on the entire processing setup. 

Since each mini-Rack in the Overview Window displays clipping information, you can easily 

watch out for over-level clipping across your entire setup. 
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Controlling MultiRack with MIDI 
Since FOH situations demand that you keep your hands on the console and your eyes on 

the show, you may not always want to control MultiRack using a mouse and a computer 

display. Instead, you may choose to control MultiRack using your digital console or other 

familiar MIDI hardware controller for greater efficiency.  

 

The following MultiRack functions can be controlled via MIDI: 

• Navigation between Racks and between plug-ins 

• Global controls such as Rack or Plug-in On/Off, Mute, etc. 

• Selected Plug-in parameter controls 

• Snapshot recall 

How is MIDI Used with MultiRack? 

Important MultiRack functions can be assigned to a MIDI hardware controller using the 

Remote Controller Editor, which is supplied with MultiRack. Assigning is simple: On the 

Editor’s interface, select the MultiRack function you wish to control, and move the desired 

knob or press the desired button on your MIDI controller to establish an assignment. Even 

when you have Racks full of processors, you can only control the plug-in that’s currently 

being displayed. This way, you always know which plug-in parameter you’re adjusting. So 

when controlling MultiRack via MIDI, you will always first select the Rack and plug-in you 

want to address, and then adjust its parameters. 

The Controller Strip 

A MultiRack Session can have up to 64 Racks, each containing up to eight plug-ins. Since 

every plug-in has several parameter controls, remote control of so many different variables 

could be a logistically complex task, and would require users to re-map MIDI links each 

time the configuration changes. MIDI mapping is simplified in MultiRack by using a matrix 

that sits between the plug-in and the MIDI controller. This matrix assigns key parameter 

control knobs and buttons to fixed matrix positions so that MIDI assignments always make 

sense, regardless of type of processor. For example, when using dynamics processors, the 

matrix usually assigns the first variable MIDI position to Threshold, the second to Ratio, the 

third to Attack, and so forth. With EQ processors, the first variable position is usually Input 

Gain, followed by Band One Gain, Band One Frequency, etc. The matrix is reflected in the 
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Controller Strip, which can be displayed at the bottom of the Rack View page by choosing 

Show Controller Strip from the View menu or by using the shortcut Ctrl/Cmd+Shift+C. 

 

 

 

The Controller Strip shows up to eight variable controls (top row) and eight switches for the 

displayed plug-in that can be remotely controlled via MIDI. Many plug-ins have more than 

eight variable and or discrete controls; to assign these additional controls, extra Controller 

Strip pages are provided. Use the Remote Controller Editor’s Next/Previous buttons to 

navigate to the relevant page of Controller Strip parameter controls. 

 

MultiRack’s standardized Controller Strip means that the relationship between hardware 

and software need be set only once. The specific parameter control will change with each 

type of plug-in, but the logic will remain consistent within groups of Waves plug-ins. 
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Assigning Hardware Control with the Remote Controller Editor 

Use the Remote Controller Editor to map relationships between hardware MIDI controllers 

and numerous MultiRack functions. Its interface displays MultiRack functions that can be 

controlled directly via MIDI, including the eight continuous and eight discrete controls of the 

Controller Strip. You can assign up to 46 MIDI links to desired MultiRack controls using a 

standard MIDI “Learn” routine:  

 

There are three categories of MIDI controlled MultiRack functions that you can assign with 

MIDI Remote Control: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Navigation Use MIDI buttons to navigate between and within Racks to select and edit 

the specific plug-in to control. You can additionally assign up to eight Hot Plug-ins that 

can be recalled by touching the assigned MIDI controls. This way, you can access 

critical plug-ins without having to navigate to them. 

 

• Plug-in/Rack Controls Once a Rack and a plug-in are selected, you have direct control 

over the Rack (levels, on/off, in/out, etc.), as well as control over the plug-in parameters. 

Plug-in control is available for the eight knobs and eight buttons shown on the plug-in’s 

Controller Strip. 

• Snapshot Recall This provides control for Next and Previous Snapshots. You can also 
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directly recall specific “Hot” Snapshots. 

 

To assign MIDI controls, launch the Remote Controller Editor by clicking Editor from the 

Control Setup tab of the Preferences window.  

 

Select a MIDI port. Use the pull-down menu to choose the port your MIDI controller is 

connected to. 

 

Assign hardware controllers to the navigation tools: 

• Click on any of the five navigation keys (Up Rack, Down Rack, Prev Plug-in, Next Plug-

in, or Select). 

• Choose the hardware control you want to assign and move or press it to communicate 

with the Remote Controller Editor. You’ll see floating text above the selected parameter, 

indicating the MIDI command assigned to the respective parameter. 

• This completes the assignment of the MIDI switch or variable controller. Proceed with 

the other navigation functions. 

 

Follow the same procedure for the eight 

continuous parameter controls and eight 

discrete switches of the Controller Strip. 

Remember, the specific plug-in parameter 

controls and switches will change with type 

of plug-in, but the position and the assigned knob on your MIDI hardware controller will 

remain fixed. 

 

You can assign control of a Rack’s Input and Output Gain, 

as well as Rack On/Off, Rack In/Out and Mute.  

 

 

 

 
 
 
 



 

 25

Remotely Triggering Snapshots 

Assign hardware switches to control the Previous and Next Snapshot function. 

When using remote MIDI control to scroll to a Snapshot, the Snapshot will 

become active immediately.  

 

By creating Hot Snapshots, you can assign up to eight Snapshots to specific MIDI switches. 

This is useful for very important or frequently used Snapshots. 

 

In the Snapshots pane, select a Snapshot you want to make Hot. Right click on the 

Snapshot name and choose a Hot Snapshot number from the pull-down menu. Once you 

create a hot Snapshot, the assignment procedure is the same as with other MIDI trigger 

assignments. Hot Snapshots are displayed in red in the Snapshots Pane and their Hot 

Snapshot number is indicated on the right side of the window. 

Hot Plug-ins 

You can designate up to eight plug-ins as “Hot Plug-ins.” Hot Plug-ins can be directly 

recalled via MIDI and/or the Hot Plug-in Panel buttons, in much the same way that Hot 

Snapshots are used. To make a plug-in Hot: 

• Select a plug-in you want to designate as Hot. 

• Right click on the plug-in and choose a Hot Plug-in number (1-8) from the submenu 

 

The plug-in will now display a numbered marker 

(H1, H2, …) indicating its Hot Plug-in designation. 

 

Once you complete the assignments, save the 

MIDI/Keyboard Setup file, using the Save or Save 

As… buttons at the bottom of the interface. 

 

 

You are now finished with the Remote Controller 

Editor and may close the application. 

 

Return to MultiRack and open the Control Setup 

tab of the Preferences window. Browse to your 
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newly created MIDI control file in the window, MIDI/Keyboard Setup File.  

Select the desired MIDI/Keyboard Setup file. The mapping you assigned with Remote 

Controller Editor will become available to MultiRack. 

 

MIDI control setup is discussed in greater detail in the section “The Preferences Window.” 

 

Hot Plug-in Panel 
 
 

The Hot Plug-in Panel is a floating window that provides quick access to 

your Hot Plug-ins. To show the panel, go to the View menu and choose 

View Hot Plug-in Panel. Use the top right corner Flip button to switch the 

window’s orientation between vertical and horizontal. The Panel holds 8 

buttons that serve as shortcuts to your Hot Plug-ins .A plug-in is 

represented by plug-in name, Rack number and name. Click on the Plug-in 

button to open the plug-in’s GUI in Rack View. 
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Show Mode 

Show Mode is a “safe mode,” used during 

performances, that lets you adjust parameters within 

plug-ins, but not change routing, configuration, and 

other settings that could cause problems in a live 

situation. When Show is selected you’re locked out from 

much of the interface - select Setup to return to the Setup mode. 

To move between Setup and Show modes, double-click the Setup/Show button. 

Shortcuts That Are Always Available 
Right click on any blank area of the Rack’s interface and you’ll have quick options to 

perform a number of common tasks: 

• Rack On/Off 

• Rack In/Out 

• Mute Rack 

• Copy Rack 

• Duplicate Rack 

• Delete Rack 

• Assign Processing Groups 

Automatic Recovery 
As MultiRack is an application for live usage, it is equipped with an automatic recovery 

mechanism. This means that if MultiRack quits unexpectedly, it will automatically re-launch 

and re-open the same Session file it was running when it crashed, with the same Snapshot 

that was recalled when the crash occurred (if applicable). 

 

Rescan Present Licenses (Edit Menu) 
If you are preparing setup and routing without licenses, i.e. without a connected USB flash drive 

or iLok key, plug-ins will load in a disabled state. While the plug-in won’t process audio you can 

still assign inserts, FX, load plug-ins and presets.  

 To enable a disabled plugin or plugins: 

• Connect your USB Flash Drive (V9) and/or iLok key (V8). 

• Go to Advanced Menu and select the “Rescan Present Licenses”. 
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All disabled plugins will be enabled. 

• You can re-enable plugins individually by right clicking on disabled plugin and choosing 

enable option from the menu. 

 

 

MultiRack Windows and Controls Explained 

 

In this section, we take a look at each of MultiRack’s windows in greater detail. If you’ve not 

read the first section of this manual, “MultiRack Quick Start,” please do so before 

continuing. There are terms and concepts discussed in the Quick Start that are essential to 

understanding MultiRack workflow. 

Status Bar 

At the top of the interface, above all of the Racks, is the Status Bar, with which you select 

modes and monitor system status. This information bar is visible from any view. 

 

 

 

 

Audio On/Off 

button 

Turns the audio engine on and off. Use this button to reset 

the engine if audio has become corrupted, or if the 

application is unresponsive. 
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Show/Setup 

button 

Double-clicking this button switches between Setup mode, 

in which you can change any setting, including audio I/O, 

Rack order, and number of plug-ins, and Show mode, 

where you can adjust plug-in parameters but not the 

“structural” aspects of the Racks. Show mode is designed 

for performance and stability, and protects you by preventing 

changes that might bring about clicks, audio drops, 

instability or glitchy behavior.  

If you find you cannot cut, paste, or move Racks, you’re 

likely in Show mode. Return to Setup mode to change the 

layout of your Racks. Setup mode allows you to edit all of 

the application’s editable parameters. It’s intended for use 

while setting up the live Session, connecting the Racks, 

adjusting the audio processing parameters, setting up 

remote options, etc. 

Snapshot button This opens the Snapshots pane, where you name, 

manage and recall Snapshots. You can also open the 

Snapshots pane by typing Ctrl/Cmd+Shift+O. 

 

 

 

Snapshot button This opens the Snapshots pane, where you name, 

manage and recall Snapshots. You can also open the 

Snapshots pane by typing Ctrl/Cmd+Shift+O. 

Snapshot pull-

down menu 

Displays the current Snapshot and allows you to quickly 

recall any Snapshot directly. 

Snapshot 

previous/next 

buttons 

Click the left arrow to recall the previous Snapshot, and 

the right arrow to recall the next Snapshot, in sequential 

order. 
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Message area Error and alert messages are displayed in this area. 

REMOTE This indicator flashes when MultiRack receives a 

remote/MIDI message. 

SYS 

(system resources 

meter) 

This meter displays MultiRack’s overall system 

resources consumption, as a percentage and in color. A 

red indicator indicates significant audio dropouts. This 

warning will hold for one second. 

 

 

A Quick Look at the Windows 
 
The MultiRack interface consists of just five windows, each of which displays details about 

your Session. Here is a brief description of the windows, after which each will be described 

in more detail. 

MultiRack Window 

This is the main user window, where up 

to 64 Racks are connected and 

controlled. Here you add Racks, fill 

Racks with plug-ins, adjust levels, and 

generally get organized. 
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Rack View Window 

This window opens when you double 

click on a plug-in within a Rack. It 

displays the selected plug-in interface, 

as well as the Rack where it’s located. 

This is where you edit plug-in 

parameters, import your favorite plug-in 

presets, and control the levels of 

individual plug-ins. In this view, each 

plug-in has its own WaveSystem 

toolbar for loading and saving plug-in 

presets. 

Group Properties Window 

Here you group sets of Racks for easier 

organization and to adjust for latency alignment 

between the group’s Racks. 

 

 

 

 

 

 

Snapshots Pane 

Lists all Session Snapshots and allows Snapshot management. Here 

you can store, rename, move, duplicate, and recall Snapshots.  
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Preferences Window 

 

Contains all application and global settings that affect the entire application. This window is 

accessed from the Edit menu (PC) or Apple menu (OS X).  

Hot Plug-in Panel 

 

The Hot Plug-in panel is a floating window that provides quick 

access to your Hot Plug-ins. To show the panel, go to the View 

menu and select “Show Hot Plug-in Panel”.  

 

 

 

 

 

 

 

 

 

 

The Windows in Detail 
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MultiRack Main View: Setting Up Your Processing Environment  

This is the view where you’ll probably spend most of your setup time. It’s here that you build 

Racks of processors. 

  

Racks are stacked one 

below another; there are 

no unoccupied slots 

between Racks. By 

default, MultiRack opens 

with the last Session used. 

 

 

 

To add a Rack, double click on the area below an existing Rack (if one exists).  

The Add Racks dialog window will appear. It allows you to add Racks below the last Rack 

in the Session. The numeric field specifies the number (1-64) of new Racks to be added. 

From the drop-down menu choose the Rack type: mono, mono-to-stereo, or stereo. 

 

When a new Rack is added, its default setup is:  

No plug-ins; Gain at 0dB; Rack on; Rack in; Mute off; No group; Untitled name; No input; 

No output. 

 

To select a Rack, click anywhere on the Rack. 

To select multiple Racks, Ctrl/Cmd+Click on the Racks you want to select, or click/draw a 

rectangle over the contiguous Racks you want to include. 

To move a Rack or Racks, select or multi-select, then drag and drop. You can also cut 

and paste Racks. As Racks move, their I/O settings follow them. Several Racks moved at 

the same time will clump together and move as one unit, and all Racks below this group will 

move downward to make room for the new arrivals.  
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The Rack Control Strip 

At the top of each Rack is a status bar that you use to control, name and put it into 

processing groups. The control strip has the following windows and buttons: 

 

 

 

 

On/Off  Disables a Rack and removes it from CPU processing. Mutes 

all signals routed to the Rack. Turning off an unneeded Rack 

results in better CPU management of the system. 

In/Out  Disables the Rack’s plug-ins and passes the signal directly 

from Rack input to Rack output. Typically used for “before 

and after” comparison or to bypass processing. 

Mute Silences the Rack, but doesn’t remove it from CPU 

processing.  Multing is performed on the Rack’s input to allow 

reverb tails and delay taps to fade gracefully. 

Rack Name  

(“Kick One” in 

this example) 

The user-defined name of the Rack. Double-click to enter a 

new name or use the pull-down menu to open another Rack. 

Group Name  

(“Drums” in this 

example) 

Refers to the name of the processing group, if any, to which 

the Rack has been assigned. Use the pull-down menu to 

assign the Rack to another processing group. 

Side chain (input) Lists all available inputs. Use the pull-down menu to select 

the input you intend to use as side chain to any of the plug-

ins inserted in this Rack. All side-chain capable plug-ins 

inserted in this Rack share the same input. Note that it is 

possible to use a mono side chain signal in a stereo 

Rack 
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Side chain (monitor) Press this button to listen to the side chain signal. Side Chain 

is monitored through the Rack’s output. 

 

Selecting Racks and Using Keystroke Commands 

You can copy, paste, delete, duplicate, and perform other operations on a Rack or Racks 

you have selected. 

• To select a Rack, click on any empty area of the Rack.  

• To select multiple adjacent Racks, click on a Rack, then Shift+Click on the most distant 

Rack of the group you want to select.  

• To select multiple non-adjacent Racks, Ctrl/Cmd+Click on several Racks. 

 

Right click on the top 

part of a selected Rack 

and you will see a pull-

down menu that offers 

several functions: 

 

 

Active(On) Turns Rack on/off, disabling and removing it from the 

CPU. This is useful for greater CPU efficiency when a 

Rack is not needed. 

Bypass Disables the Rack’s plug-in processing and passes 

signal from Rack input to Rack output. 

Mute Mutes entire Rack but doesn’t remove plug-ins from 

CPU. 

Cut Rack(s) Cuts the Rack and its contents and places them in the 

computer’s clipboard. 

Copy Rack(s) Copies the Rack and its contents into the computer’s 

clipboard. 
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Paste Rack(s) Pastes the Rack, including its content and state. 

Duplicate Rack(s) Creates a copy of the Rack, including its content and 

state. 

Delete Rack(s) Deletes the Rack. Racks below this Rack will move 

upward. 

Global Paste Rack Copies the Rack’s parameters from the recalled 

Snapshot and pastes them into the selected Snapshots 

when “Global Paste” is selected in the Snapshot Pane. 

For example, if your singer has a cold and you need to 

EQ the vocals differently, Global Paste allows you to 

change specific settings, then embed these parameter 

changes into all of the Snapshots you’ve made, rather 

than having to adjust each Snapshot separately. The 

Global Paste function is discussed in detail in the 

“Snapshots” section of this manual. 

Recall-Safe Rack Places the selected Rack into a “safe” mode that 

protects it from Snapshot recalls. Recall Safe Racks 

(or plug-ins) are unaffected by all Snapshot recalls, 

even if a Snapshot has parameters that should be 

changed on Snapshot recall. 

Group Presents a list of available processing groups from 

which to choose. 

Switch Rack Type Allows you to change the Rack configuration (mono, 

stereo, mono-to-stereo). 
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Latency: Display only – displays the Rack’s current 

accumulated latency according to the inserted plug-

ins, in samples. 

 

Right-click on a plug-in icon and you will see a pull-down menu that offers several functions: 

 

 

 

Copy Preset Copies the plug-in’s preset  

Paste Preset Pastes the plug-in’s preset to another plug-in instance 

Disable Plug-in Disables the plug-in and takes it off the computer’s CPU (the 

plug-in doesn’t take any CPU resources) 

Remove Plug-in Removes the plug-in from the Rack 

Copy Plug-in Copies the plug-in including its configuration 

Replace Plug-in Replaces the plug-in with a copied plug-in 

Enable Side Chain Enables side chain functionality for the plug-in (applies only 

if the plug-in is side-chain capable) 

Plug-in list Allows you to replace the selected plug-in with one of the 

listed plug-ins 

Recall-Safe Plug-in Sets the plug-in to Recall Safe. 

Set a Hot Plug-in Allows you to set the plug-in as a Hot plug-in. Up to 8 plug-

ins can be set as Hot. 

 



 

 38

Input and Output Sections 

At the far left of a Rack is its Input Rail, where audio is selected from 

outside sources. Here you choose an input source, and indicate mono or 

stereo.  

 

 

To the right of the Input Rail is the Input Audio Fader, with a range of ±18dB.  

On the far right side of each Rack are the Output Rail and the Output Audio Fader. Rack 

audio input and output levels are stored within Snapshots. 

 

Each Rack can be connected to input and output channels as follows: 

• A mono Rack can connect to a single input channel and a single output channel. 

• A stereo Rack can connect to a consecutive-pair of input channels and a consecutive-

pair of output channels. 

• A mono-to-stereo Rack can connect to a single input channel and to a consecutive-pair 

(starting with odd) output channels. 

• A physical input channel can be connected to more than a single Rack, feeding them 

simultaneously. 

• A physical output channel can be connected to only one Rack. Two or more Racks 

cannot share the same output. 

 

Use the same menu with which you set the 

input/output channels to switch the channel 

configuration of the Rack. 

 

 

 

 

Adding Plug-ins to a Rack 

To add a plug-in to a Rack, click on the small arrow to the right of the Input Fader. Select a 

plug-in from the pull-down menu. An icon representing the plug-in will appear on the Rack, 

along with a new small arrow that you can click to add a new plug-in to the right of the 

existing one.  
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Signal flow within a Rack is always from left-to-right.  

While in the Main view, you can always change the plug-in sequence within a Rack by 

grabbing a plug-in and moving it to the desired location. Each plug-in icon has an In switch 

with which you can bypass that processor without disengaging it from the Rack. There is 

also a level meter on the icon that shows plug-in output level.  
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Rack View: Using Your Plug-ins 

Double click on a plug-in’s icon to open its interface and enter MultiRack’s Rack View.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Here you adjust each plug-in. If you’re already familiar with Waves plug-ins, this window will 

be very easy to use. At the top of each plug-in’s window is a WaveSystem Toolbar, used to 

load, save, and compare processor settings. The layout of the WaveSystem Toolbar may 

vary from one plug-in to another. Use this toolbar to save plug-in or Rack-specific presets. 
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WaveSystem Toolbar Buttons 

Undo Undoes the last change(s) you made within the plug-in.  

Setup A 

(Setup B) 

Toggles between two setups, allowing you to compare 

different settings. This facilitates quick A/B comparisons and 

lets you determine which of two settings works best without 

having to save a preset. An asterisk (*) on the button 

indicates that changes have been made since a preset was 

loaded. 

A►B; B►A Copies the current settings to the second setup register. 

The direction of copying is from the currently shown setup 

to the one not shown. 

Load Here you load factory presets, user presets, and other 

preset files. Factory presets are permanent elements of the 

Load popup menu, created by Waves. They cannot be 

changed or deleted.  

 

You can turn the current settings of the plug-in you’re using 

into a user preset by clicking the Save button. User presets 

can be changed and deleted, and the preset files you save 

through the WaveSystem toolbar will appear as Load menu 

presets until you close the preset file or close the plug-in. 

 

Some plug-ins have a very large library of presets, too large 

to display on the main pull-down menu. To load these 

library files or load presets from external files, select “Open 

Preset File.” Waves preset files are saved with an .XPS 

extension. 

 

To delete a user preset, hold Ctrl/Cmd+click on the Load 

menu. You will be given the option of deleting the user 

preset.  
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Save Save your plug-in presets here. You can save the current 

parameters as a user preset in the Preset menu, or create a 

new file. If you choose to save the preset as a new file — 

outside the plug-in’s Preset menu — WaveSystem will ask 

you where you want to put it. 

? (Help) Opens the PDF manual for the current plug-in.  

 
Clicking on the Waves logo will bring up the “About This 

Plug-in” page, providing information about the plug-in. 

 

There are several quick ways to move from one plug-in to another within a Rack: 

• Use your keyboard’s left and right arrows. This will move you through the list of plug-ins 

in the Rack, opening each plug-in interface as it is selected. Note: If the current plug-in 

contains a selected value window, this will not work, and it may change the parameter 

within the selected value window. 

• Click on another plug-in icon. This will move you directly to the new plug-in and open its 

window. 

Controller Strip 

Selecting Show Controller Strip from the View menu while in Rack View reveals a floating 

window at the bottom of the screen that indicates which parameters of the current plug-in 

are currently accessible for MIDI remote control.  

 

The upper row displays eight 

continuous controls (usually relating 

to knobs or faders); the bottom row 

represents eight discrete buttons or 

toggles. Some plug-ins use more than 

eight variable controls or discrete 

switches. For these plug-ins, 

additional Controller Strip pages are available. The Remote Controller Editor allows you to 

assign a MIDI switch to navigate to Controller Strip pages where the desired controls are 

displayed. 
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Group Properties Window: For Organization and Latency Alignment  

This window allows you to group several Racks together. Racks often have something in 

common, and it may make sense to assign all of these similar Racks to a group. Grouping 

all of the channels of your brass section, or drums, or audience, then assigning these 

groups a color, helps you to keep track of Racks in concert situations. Also, each rack will 

display the name of the group, further aiding quick visual organization. 

 

Plug-ins may impose a delay (known as “latency”) as signal passes through them. Often, 

this is not a problem. However, there are times you will want to time-align all of the Racks in 

a group, to compensate for different processor latencies that may cause phase-related 

problems.  

 

Use the Group Properties window to create groups of 

Racks and align their latencies. Open this window from 

the pull-down menu located at the top of a Rack or from 

the Edit menu. 

 

You can also open this window from the Edit menu (Ctrl/Cmd+G). 

 

In the Group Properties window, you can create up to 16 processing groups, each of 

which can contain any number of Racks. 

 

 

 

 

 

 

 

 

 

 

Create a group by double clicking on a Group Name cell and typing the name you want to 

assign the group. Now, decide how you want to align the processors within the group.  
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None A group is created, but there is no latency alignment. 

Auto The group is delayed to match the latency of the Rack in the group 

with the greatest total latency. 

Manual Manually delay the group by a specific value by entering it in the 

Latency field. The value is displayed in samples, milliseconds, 

meters or feet, depending on your choice in the pull-down window. 

The minimal value allowed for this setting matches the latency of the 

Rack in the group with the greatest total latency. 

 

 

Groups are color-coded to make for easier identification. Color selection is based on 

placement in the list, and is not user-definable. At the bottom of the Group Properties page 

is the Align All section.  

 

 

Here you can align all of the groups of Racks in order to create a unified timing for all 

channels. The Auto setting will offset all of the groups to match the timing of the group with 

the greatest latency, while Manual will delay all groups by a specific value.  

 

 

Below the Align All section is the “Speed of Sound” setting. This parameter control, 

expressed in meters per second, allows you to calibrate MultiRack’s latency controls to 

match measured speed of sound. The speed of sound at sea level, at a temperature of 20 

degrees Celsius and dry air, is 343 meters per second.  
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Snapshot Pane: Automating Your Racks 

One of the main benefits of a plug-in based processing host for live applications is the 

ability to create detailed presets and recall them live, during concerts. The Snapshot Pane 

is where you store, recall and manage the Snapshots that contain all of the parameters of 

the plug-ins that make up your processing Racks. It’s here where your programming efforts 

pay off. 

Snapshots contain the following parameters: 

• Rack input and output gain 

• Rack in/out, mute and on/off states 

• Current plug-in parameters 

• Side Chain settings 

 

Snapshots are contained and saved as part of a Session file. A single Session file can 

contain up to 1000 Snapshots, which are displayed as a vertical play list. Snapshots can 

also be exported to or imported from files in order to integrate them into a Session.  

 

Use Snapshots to change the state of Racks (Mute/In/Off), 

levels, and, most importantly, the settings for the plug-ins. 

Snapshots do not change the physical configuration of a 

Session, so you cannot use a Snapshot to change the audio 

I/O, the Rack order or the plug-ins embedded in a Rack. 

 

To open the Snapshot Pane, click the Snapshots button on 

the Status Bar or select Open Snapshot Pane from the 

Snapshots menu (F7). The Snapshot Pane can hold up to 

1000 Snapshots (the maximum per Session). 

 

To save a Snapshot of your existing Rack environment, click 

Store or Store As. As with most programs, these two 

commands do the same thing with empty Snapshot registers, 

but if a Snapshot already exists, Store will overwrite the 

current Snapshot, while Store As will allow you to create a 

new name without overwriting the Snapshot and store the 

Snapshot in an empty slot in the “playlist.” 
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If you’re saving a new Snapshot, the Store Snapshot As pane will open. Choose the list 

position where you want to save the new or modified Snapshot and click Store. If you are 

overwriting an existing Snapshot, you will see this warning: 

 

 

 

 

 

Once you have named a few Snapshots, the Snapshot Pane may look like this: 

 

Note that selected Snapshots are 

highlighted, and the currenlty recalled 

Snapshot’s name appears in boldface 

and its number is highlighted in 

green. At the bottom of the pane is an 

area where you can write notes about 

the selected Snapshot. 

 

 

 

To recall a Snapshot, either double-click on its name, or select the Snapshot and then click 

Recall.  

 

It’s often useful to create a copy of a Snapshot to use as a starting point for creating similar 

setups. Copy a Snapshot by selecting it, then clicking Duplicate. The copy will appear at 

the end of the Snapshot list. The word “Copy” will be appended to the Snapshot name; 

right-click and choose “Rename” to choose a new name for the new Snapshot. 

 

Select a Snapshot and click the Delete button to permanently remove it from the Snapshot 

List.  

 

Global Paste enables you to copy a plug-in’s or a Rack’s parameters into one or more 
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other Snapshots. This is useful when you’ve set up several Racks filled with plug-ins and 

you decide to change plug-ins settings across several Snapshots. Say, for example, that 

after several rehearsals you arrived at the perfect plug-in settings for a particular 

instrument, an instrument that is included in numerous Snapshots. Rather than opening 

each of the Snapshots, making the desired adjustments and then overwriting the 

Snapshots, use Global Paste to globally make the changes: 

 

1. Begin by clicking Global Paste. The button will flash to indicate that the Snapshot Pane 

is in the Global Paste mode. 

2. Select the target Snapshot or Snapshots that you want to modify. To select multiple 

Snapshots, Ctrl/Cmd+Click on the desired target Snapshots, or Shift+Click to select 

several contiguous Snapshots. 

3. In the Rack windows, select the plug-in or Rack whose state you want to copy to the 

selected Snapshots. Right-click on the plug-in and choose Global Paste Plug-in/Rack 

from the menu. Repeat this for each of the plug-ins or Racks whose settings you want 

to Global Paste. 

 

 

 

 

 

 

 

 

 

4. Press the Global Paste button in the Snapshot Pane once again to end the process. 
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Import allows you to add Snapshots from another MultiRack 

Session.  

� Click on the Import button. A browser window will appear. 

� Locate the MultiRack Session that contains the Snapshot 

you want to import into the current Session. The Import 

Snapshot window will appear.  

� Choose the Snapshot(s) you wish to add, and then click 

Import. 

 

 

 

 

 

Remember, Snapshots contain information about parameters, not configurations, so the 

source and target Sessions must have the same plug-in content and order in each Rack. 

 

Hot Snapshots 

A Hot Snapshot is a Snapshot that can be recalled directly via a dedicated user-specified 

MIDI control message or a keyboard key (see the MIDI remote control section for more 

details). Unlike other Snapshots that are recalled via MIDI program/control change 

messages or the Previous/Next buttons, Hot Snapshots can also be directly recalled 

anytime. Therefore, a Hot Snapshot can be moved to another slot while maintaining its Hot 

Snapshot designation and remote control association. (Note: Designating a Snapshot as 

Hot does not void the option to recall it via its index number by MIDI program change or via 

the Previous/Next buttons.)  

  

To designate an active Snapshot as “Hot,” right click on the Snapshot name and choose an 

available Hot Snapshot number. The Snapshot name will be highlighted in red and the 

number of the Hot Snapshot will appear next to its name. Use the Remote Controller Editor 

to assign Hot Snapshots to specific MIDI switches on your hardware controller. 
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Preferences Window: Global Controls 

Enter the Preferences window from the Edit menu (PC) or MultiRack menu (OS X) ,or by 

typing “Ctrl+P” (PC) or “Cmd+,” (Mac).  

There are two tabs in the Preferences window: 

• System Setup 

• Control Setup 

• Plugin Manager 

 

System Setup – Audio Section 

On this simple page, you choose the device (sound card) you will use for MultiRack’s audio 

input/output. If you have more than one available audio device, clicking on the window will 

reveal a pull-down list of available options from which to choose your I/O. System sample 

rate and buffer size are also set here. 

 

System Setup – System Section 

 

The System section allows you to set certain application-wide preferences: 
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Activate auto-save in Show mode. You may not want to use MultiRack’s auto-save 

feature during a concert, so as to avoid any processing interruptions, De-select this box to 

turn off auto-save. 

Show configuration change alert. Selecting this option will result in a warning each time 

you attempt to modify any Rack configuration. This is helpful when you are learning the 

application, but may prove annoying for more seasoned users. 

 

Recall first Snapshot when Session loads. If you regularly start your shows with the first 

Snapshot, this is a good choice. 

Enable verbose log. This option places MultiRack in a “debug” mode that outputs what is 

called a “verbose data file”. It’s used to collect data that technical support may require. 

When selected, the message area of the Status Bar displays a flashing message: “Verbose 

Output.” The output file is titled “DebugMultiRack_date<dd.mm.yyyy>.txt. 

Load application in last View mode. If you want MultiRack to remember the last mode 

(Show/Setup) you were in, choose this option. 

Load last session on application launch. If you select this option, MultiRack will always 

open with the last session you used when you exited the application. 

Open in Full Screen mode. Selecting this option will cause MultiRack to open in Full 

Screen mode. 
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Plugin Manager (working with v8 and v9 plugins.) 

 

 

 

Click Plugin Manager Tab in Preferences. MultiRack V9 supports both V8 and V9 plugin 

versions. Depending on what license you have or intend to work with select V8, V9 or 

both and click Ok. Both plugin versions are installed on your PC. Checking the version 

entry in the Plug-In Manager tells MultiRack what version(s) you want it to scan when it 

loads. You can change your selection at any time.  
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Control Setup Tab 

• Use this page to control how MultiRack 

interacts with outside MIDI controllers. 

MIDI In and MIDI Thru display all MIDI 

ports available to the application. 

MultiRack receives MIDI on its selected 

MIDI In ports and echoes incoming MIDI 

to selected MIDI Thru ports. 

• Set MIDI channel for snapshot recall 

determines which MIDI channel (none; 

1-16) will be used to initiate/recall stored 

Snapshots. MultiRack will recall 

Snapshots #1-128 on receiving MIDI 

program change messages (#0-127) on 

the set MIDI channel.  

• Set MIDI Control Change messages 

for snapshots recall determines which 

control messages — sent on the 

above-set MIDI channel — will be used 

to initiate/recall Snapshots #129-1000. For example, if you select Control Change 

message #7 to recall Snapshots 129-256, then sending CC#7 with value 0 will recall 

Snapshot #129. Value 2 will recall Snapshot #130, and so forth. 

• Set MIDI Pickup Mode determines how MultiRack will respond to parameter changes. 

When None is selected, all user changes are directly reflected in the interface. 

Takeover move means that existing parameter values will not change until you have 

“swept” over it in either direction.  

• MIDI/Keyboard Setup File allows you to browse to the control file created in the 

Remote Controller Editor. Choose the file that contains the MIDI mapping for your 

hardware setup.  

 

You can open the Remote Controller Editor from this page. If you opened the editor from 

the Control Setup Tab and MultiRack is still open, settings will automatically update as the 

file is modified. 
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Hot Plug-in Panel 
 

The Hot Plug-in Panel is a floating window that provides quick access to your Hot 

Plug-ins. To show the panel go to the View menu and choose View Hot Plug-in 

Panel. Use top right corner Flip button to switch the window’s orientation 

between vertical and horizontal. The Panel holds 8 buttons that serve as 

shortcuts to your Hot Plug-ins .A plug-in is represented by Plug-in name, the 

Rack number and name. Click on the Plug-in button to open the plug-in’s editing 

window in Rack View.
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MultiRack Menus 

MultiRack is controlled mostly from within its five windows, so there are very few application 

menus. Most menu commands offer keystroke shortcuts, so it’s worthwhile studying the 

menus in order to learn how to quickly navigate through MultiRack’s commands. 

File Menu 

Menu Item Definition 
Keyboard 
shortcut 

Comments 

New 
Session 

Opens a new 
Session in default 
setting 

Ctrl/Cmd+N  

Open 
Session 

Opens a Session file Ctrl/Cmd+O  

Open 
Recent 
Session 

Lists recent Session 
files 

  

Close 
Session 

Closes the Session Ctrl/Cmd+W  

Save 
Session 

Saves the Session 
to the same file 

Ctrl/Cmd+S  

Save 
Session 
As… 

Saves the Session 
under a different 
name 

  

Exit 
Closes the 
application  

Ctrl/Cmd+Q 

Windows 
only.  
On OS X this 
command is 
in the 
MultiRack 
menu. 

 
 
 
 
 

MultiRack Menu (OS X only) 

Menu Item Definition 
Keyboard 
shortcut 

Comments 

About 
MultiRack 

Reveals information 
about current 
version of 
MultiRack. 
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Preferences… 
Opens the 
application’s 
Preferences window 

Cmd+,  

Quit 
MultiRack 

Closes the 
application.  

Cmd+Q  

 

Edit Menu 

Menu Item Definition 
Keyboard 
shortcut 

Comments 

Undo 
Undoes the last 
action 

Ctrl/Cmd+Z  

Redo 
Redoes the last 
Undo action 

Ctrl/Cmd+Y  

Cut 
Cuts selection to 
copy buffer 

Ctrl/Cmd+X 

Applies to 
selected plug-
ins, Racks, 
and 
Snapshots 

Copy 
Copies selection to 
copy buffer 

Ctrl/Cmd+C 

Applies to 
selected plug-
ins, Racks, 
and 
Snapshots 

Paste 
Pastes clipboard to 
selection 

Ctrl/Cmd+V 

Applies to 
selected plug-
ins, Racks, 
and 
Snapshots 

Duplicate 
Duplicates selected 
Rack or plug-in 

Ctrl/Cmd+U  

Delete 
Deletes the selected 
Rack or plug-in 

Delete  

Select All 
Selects all Racks. 
Applicable only in 
MultiRack window.  

Ctrl/Cmd+A  

Deselect All 
Deselects all Racks. 
Applicable only in 
MultiRack window. 

Ctrl/Cmd+D  

Invert 
Selection 

Selects all 
deselected Racks; 
deselects all 
selected Racks. 
Applicable only in 
MultiRack window. 

Ctrl/Cmd+I  
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Add 
Rack(s)… 

Opens the Add 
Racks dialog 
window. Applicable 
only in MultiRack 
window. 

Ctrl/Cmd+R  

Auto Route 
All Racks… 

Assigns I/Os to all 
Racks consecutively, 
based on their top-
down order in MR’s 
main window. 

Ctrl/Cmd+U  

Preferences 
Opens the 
Preferences window 

Ctrl/Cmd+P 

Windows 
only. On OSX 
this command 
is in the 
MultiRack 
menu 
(Cmd+,). 

 
Group 
Properties … 
 

Opens the Group 
Properties window 

Ctrl/Cmd+G  

 
Rescan 
Present 
Licenses 
 

Rescans currently 
available licenses on 
connected USB Flash  
Drive (V9) and/or iLok key 
(V8).  
 and enables all 
disabled plug-ins in 
the Session 

Ctrl/Cmd+E  

 
 

View Menu 

Menu Item Definition 
Keyboard 
shortcut 

 

Mainview 
Mode 

Displays the 
Session in the Main 
view 

F4  

Overview 
Mode 

Displays the 
Session in Overview 
Mode 

F5  

Rackview 
Mode 

Displays the Rack 
view and its housed 
plug-in’s interface 

F6  

Show Mode 
Switches MultiRack 
to Show Mode 

Ctrl/Cmd+Alt+S  

Setup Mode 
Switches MultiRack 
to Setup Mode 

Ctrl/Cmd+Alt+T  
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Show 
Controller 
Strip 

Opens the 
Controller Strip in 
the Rack view.  

Ctrl/Cmd+Shift+C  

Show Hot 
Plug-in Panel 

Opens Hot Plug-in 
floating Pannel 

Ctrl/Cmd +T  

Full Screen 
Displays the 
interface in full 
screen. 

F8  

Audio Menu 

Menu Item Definition 
Keyboard 
shortcut 

 

Turn Audio 
On/Off 

Turns MultiRack’s 
audio engine on and 
off 

Ctrl/Cmd+Alt+J  

Rack(s)    

Active 
Turns the selected 
Rack(s) on and off 

  

Bypassed 
Bypasses the 
selected Rack(s) 

  

Mute 
Mutes the selected 
Rack(s) 

  

 

Snapshots Menu 

Menu Item Definition 
Keyboard 
shortcut 

Comments 

Open 
Snapshot 
Pane 

Opens/closes the 
Snapshot Pane in 
MultiRack window. 

F7  

Store 
Snapshot 

Stores Snapshot 
parameters. If a 
Snapshot already 
exists in the 
selected register, 
“Store” will 
overwrite. 

Ctrl/Cmd+Shift+S  

Store 
Snapshot 
As… 

Saves current    

Recall 
Previous 
Snapshot 

Recalls the previous 
Snapshot in the play 
list. 

Ctrl/Cmd+Shift+< 

Previous is 
relative to the 
currently recalled 
Snapshot 
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Recall Next 
Snapshot 

Recalls the next 
Snapshot in the play 
list. 

Ctrl/Cmd+Shift+> 

“Next” is relative 
to the currently 
recalled 
Snapshot. If the 
next Snapshot 
slot is empty, Next 
jumps to the next 
occupied slot. 

Global Paste 
Mode 

Turns Global Paste 
Mode on and off 

Ctrl/Cmd+Shift+G  

Import… 

Opens a Session file 
to allow you to 
import snapshots 
from 

Ctrl/Cmd+Shift+I  

Move 
Snapshot(s) 
To… 

Moves the selected 
Snapshot(s) to a 
user-specified 
location in the 
Snapshot list. 

  

 
 
 
 

Help 

Menu 
Item 

Definition 
Keyboard 
shortcut 

Comments 

Read 
MultiRack 
manual 

Opens MultiRack 
PDF manual 

Ctrl/Cmd+Alt+? 

If the help 
manual is 
unavailable, visit 
www.waves.com. 

Go to 
Waves web 
site 

Launches the 
default browser 
with the URL 
www.Waves.com 

  

About 
MultiRack 

Opens page 
containing 
information about 
current version of 
MultiRack 

 
In OS-X, this 
item is in the 
Apple menu 
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